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DM-SSG-001-20130712 Screen Scrape Guide

This guide describes the Screen Scrape feature used with the Document Manager software from

Document Logistix Ltd.

As the software evolves, this guide may not reflect exact screen layout changes, but core
functionality remains the same.
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Preface Screen Scrape Guide

This section provides an introduction to this guide.

This guide describes the Screen Scrape feature in Document Manager.

This guide is intended for users of the Document Manager software, specifically those who use the
Screen Scrape feature.

Readers should have a basic knowledge of Document Manager.

For more information on installing, administrating and using Document Manager, refer to the
following:

Document Manager Installation Guide
Document Manager Administration Guide

Document Manager User Guide

Throughout this manual, a number of conventions are used. The list below details these
conventions:

On-screen items, including buttons, tabs, menu items, field names and dialog box names
are shown in bold, for example, click the Save button.

Keys or key combinations that you have to press on the keyboard are shown in upper case
and in angled brackets, for example: <CTRL> + <X>.

User input (information that you have to enter), object names and references to completed
fields are in single quotation marks, for example, enter the value ‘%PROMPT".

Cross-references are in italics; for example, see 1.4 Conventions on page 1 for more
information.
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Additional information is provided using icons to draw attention to them:

O NOTE: Notes are used to give supplemental or important information about the subject
matter.

! > WARNING: Warnings are used to provide important pieces of information.

TIP: Tips are used to suggest shortcuts or things to do to make using Document Manager
$ products easier.

The following terms are used in this guide:

Document Manager: The Document Manager program from Document Logistix. See the
Document Manager User Guide for more information.

Document Manager Administration Module: The Document Manager Administration
Module enables system administrators to configure the Document Manager system. This
has been abbreviated to the ‘Administration Module’ in this guide. See the Document
Manager Administration Guide for more information.

Screen Scraping: This is the action of reading information from an external application (for
example, data displayed in fields), which is then used as the search criteria in a Document
Manager search for documents or folders.

Hotkey: A hotkey is a keyboard key or combination of keys that initiates the Screen Scrape
process. It is defined in User Settings.

OCR: Optical Character Recognition (OCR) is an automatic electronic process to read
information from an image or scanned document, used typically to automate data entry.

Screen Scrape Profile: A profile holds the settings to enable users to perform a Screen
Scrape, typically for a particular application and using a specific data capture method. The
Document Manager administrator usually defines Screen Scrape profiles.

Additional Document Logistix products are available to further enhance the document
management process. For more information about them, please refer to our Website,
www.document-logistix.com or speak to an authorised reseller.
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Screen Scraping is a method for automating a search based on the information displayed in
another application. Screen Scraping is a shortcut for searching, as Document Manager
automatically retrieves the folder, sub-folder, or document you require.

Instead of using the search tools in Document Manager, you can save time by having Document
Manager read all the search criteria from an external application. Search criteria can include text
searches, all fields and even document type.

For example, you can conduct a search in Document Manager for an invoice based on the
information displayed in a Finance application program, or an employee folder based on
information displayed in a Personnel Records application.

If Screen Scraping has been configured by the local System Administrator, the search can be
initiated by simply pressing a 'hotkey’ while using an external application. The hotkey is defined on
the Integration tab in User Settings (see 2.1 Defining a ‘Hotkey’ on page 4 below).

To activate the 'Screen Scrape’ feature, the relevant screen in the external application must be the
active window (e.g. viewing the details of an invoice in a Finance application). Press the predefined
hotkey (for example, <ALT> + <F3>) and Document Manager searches for the related document(s)
or folders(s). The hotkey Search in Progress dialog box may display while the search is in progress.

When the search finishes, Document Manager displays the search results in a new tab or window.

If the search type configured is a Folder Search, and no matching folders are found, an option to
create a new folder is displayed. The Create New Folder dialog box displays with index fields
prefilled with data from the application that was the basis of the search (as shown in Figure 1):

"'/ Create Mew Folder

Drrawer r.-], Human Resources [ o Ok H # cancel l

: J. | Access Permissions |

Field Mame | 'vale

Surname Cowell
First Mame Gizma :&

Erplaoyes Ma

] These fields were
Gender 'scraped’ from the
Departrent | application.

Date of Birth /
Mat Ins Mo AB12345EC

Access From

Figure 1: Create New Folder from Screen Scrape
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Document Manager’s Screen Scrape feature provides rapid integration with most applications
without requiring any software development.

Setting up Screen Scrape is relatively simple. It requires no programming or database knowledge. A
typical Screen Scrape profile can be defined in just a few minutes, and is available to all Document
Manager users.

Other document management products integrate with other applications using coded database
links. Screen Scrape requires no code-level integration; therefore, the integrity of the target
application is not in question. This allows Document Manager to safely integrate with both the
simplest and most sophisticated applications, such as SAP.

The types of application with which Document Manager can integrate using Screen Scrape include:
Conventional Windows Applications with ‘Forms’ type layouts
Database/Spreadsheet Applications with rows and columns of data
Legacy DOS Text-based Applications
Terminal emulation sessions to Mainframe/Mini applications
Web and/or Java applications
Terminal Services/Citrix Sessions

All Screen Scrape profiles apply system-wide to all users of Document Manager. Each user may
decide if he/she wishes to use the Screen Scrape feature or not and define what hotkey to use. The
hotkey can be a combination of keystrokes that is not used by any of a user’s other programs.

To define a Screen Scrape hotkey:

Click the File tab and select User Settings. The User Settings dialog box displays. Click the
Integration tab.

Select the Enable Hotkey / Screen Scrape checkbox (to turn off the Screen Scrape feature,
clear this box).

When setting the hotkey, it is recommended that you select one or more of the control keys
(<ALT>, <SHIFT> or <CTRL>) in addition to an item from the drop-down list. This will
require the selected control key(s) to be held down while the hotkey is pressed, preventing
the user from accidentally activating the Screen Scrape feature.
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In the example below, <CTRL> + <Home> has been selected to be the hotkey combination:

Bs User Settings

General | Drawers |ntegration | Capture | Printing | Check-Out

~Hat F.ey Setup far Screen Scrape
[+ Enable Hotkey # Screen Scrape

Hotkey [ Al Home - |
[ Shift
v Cl

Screen scrape OCF reduce captured image bo mono— Threshold |24

Once the hotkey has been set, click OK.

This is the only instance a user will need to define the hotkey, except if the user decides to change

the hotkey or combination. Once defined, the hotkey is automatically enabled whenever Document
Manager is launched.

Each user can configure their own hotkey, so different users may be using different hotkeys but
they will activate the same Screen Scrapes.

O NOTE: The hotkey operates system-wide; Document Manager will respond to the hotkey no
matter which application the user has open when it is pressed.
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If you are having difficulty generating an image that can be read by Optical Character Recognition
(OCR), for example when setting up an OCR Screen Scrape profile, you can generate a black and
white image to try to improve the OCR process. This may improve the accuracy of the OCR process
when dealing with colour or complex images.

To generate Black and White OCR Images:

Click the File tab, select User Settings and click the Integration tab.

Select the checkbox Screen scrape OCR reduce captured image to mono to generate
black and white images for OCR Screen Scrapes:

~Hat ey Setup far Screen Scrape
o Enable Haotkey # Screen Scrape

Hotk.ep Al F5 -
Shift
o Chd

| Screen scrape OCR reduce captured image to mono T hreshold 124

Enter a Threshold value to determine whether colour or greyscale pixels become black or
white. The value 0 equates to a black pixel and 255 equals white.

Click OK to save your changes and close the User Settings dialog box.
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Once a hotkey is defined, you can set up Screen Scrape profiles. Multiple profiles can be created for
the hotkey for different applications, or for separate windows within a single application. Before
you define Screen Scrape profiles, you need to consider from which screens you are going to
Screen Scrape in an external application and identify the information on those screens that is going
to be used for the document or folder search.

Are the screens presented the same way to all users of the application? If not, you may need to
configure different Screen Scrape profiles to be used by different users, providing the relevant

screens are sufficiently different to be identified separately, so that the different profiles can be
triggered by each user’'s own hotkey.

Users need the correct permission to configure Screen Scrapes, which is set within the Document
Manager Administration Module (see the Document Manager Administration Guide for more
information). Ensure the users that need to define Screen Scrape profiles have permission to do so.

The best way to understand how Screen Scraping works is to create and use an example profile;
there is a ‘"dummy’ application called Employee.exe in the Document Manager program directory.

This is not a real application; it is used purely to illustrate the concepts of Screen Scraping.

Locate the Empoyee.exe program in the Document Manager program directory and run it.
This should display a dialog box similar to the one shown in Figure 2:

B Sample Personnel Program EI

— Emplayee Details

Staff Mumber |1 23449

Laztname |I:nwell

First Marne(z) |I3izmn

Title |_Mr Sex IMaIe v|
Mational Ins Mo IAB123455E

Home Phone |

Department IHH ;I

Figure 2: Sample Personnel Program

Imagine this is your Human Resources (HR) application displaying the HR details of one of your
employees. You can change the details in the fields if you wish.
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To start creating a Screen Scrape profile:

Screen Scrape Guide

Make sure the Sample Personnel Program is the active application, press the Hotkey (for
example, <CTRL> + <F3>) and the Hotkey Capture in Progress message displays:

HotKey Capture in Progress.

Following which, if there is no existing Screen Scrape Profile that matches this application,
you will be prompted to create a new profile:

Document Manager Template Matching

Mo Hotkey templates match Sample Personnel Program
Would you like to define one now?

Click Yes and the Screen Scrape Setup wizard will be presented:

Hotkey [/ Screen Scrape Setup.

Step 1 - Select a drawer to search
Step 2 - Select whether the search is for & folder or document

Step 3 - Select the method for capturing data from the applications window

Drawer |Ar1\r

-~ Search Type
(8 Folder Search/Create (Z) Document Search

[T] Automatically open folder fdocument if only 1 match is found

~Window Data Capture Method
(%) Windows Objects - Use this for standard Windows applications

() Dos/Text - Use this for DOS applications, Terminal Emulation, Clipboard contents etc
() GridfCells - Use this for spreadsheets, applications that display data in a grid etc

(1 OCR - Use this for web pages, java apps, citrix sessions, other application types

| wl:anoel |

| "'25 Mext |

D
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This wizard guides you step-by-step through creating the Screen Scrape profile. Each step gives
you directions at the top of the screen and you can click Next to move forward to the next step.

Step 1 is to specify the drawer in Document Manager that contains the documents that relate to
the application from which you will 'scrape’ data:

Drawer |Ar11_r 'r|

Step 2 is to determine if you are searching for a folder or a document:

Search Type
(% Folder Search/Create (Z) Document Search

[ Automatically open folder /document if enly 1 match iz found

For the Sample Personnel Program example, we would be looking at an employee record so would
probably want to find the employee’s folder. This means it would be a Folder Search. (If we were
looking at Invoice details in the external application, we would probably want to find the actual
invoice; so it would then be a Document Search.)

If the search returns only one result, you have the choice of displaying the search list with only one
document or folder, or opening the document/folder. This is your preference; however, the option
to open the document/folder is typically selected. It can be changed later.

Step 3 is to define the data capture method for the external application window:

~Window Data Capture Method
(®) Windows Objects - Use this for standard Windows applications
[ Dos/Text - Use this for DOS applications, Terminal Emulation, Clipboard contents etc

() Grid/Cells - Use this for spreadsheets, applications that display data in a grid etc

(21 OCR - Use this for web pages, java apps, dirix sessions, other application types

There are four options to choose from and your selection depends on the nature of the program
you are trying to scrape from. Here are some guidelines:

Windows Objects — This option is usually selected when the program is a conventional
Windows form-based program that runs on your desktop (not in a browser) and has

information displayed in fields, with buttons etc., similar to our Sample Personnel Program.
About 70 percent of such programs will screen scrape using this method, and for those that

LOGISTIX
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do, this is probably the most reliable method. See 4 Windows Objects Example on page 11
for how to define a profile for Windows Objects using the Sample Personnel Program.

O NOTE: Do not use this method for Web applications or applications running on
remote sessions like Citrix or Terminal Services.

Dos/Text — This option is usually selected when the program displays its information in
conventional rows of text, such as old-style terminals or even legacy DOS applications. Use
this option if the application is a legacy DOS application or a terminal emulation session.
See 5 DOS/Text Screen Scrape Example on page 18 for more information on DOS/Text
profiles.

This option could also be used where no other data capture method will work, but data
from the application being scraped can be copied to the Windows Clipboard.

Grid/Cells — This option is typically used when scraping from spreadsheets such as
Microsoft Excel. It uses the Windows Clipboard for transferring information from the
application to Document Manager. Use this option when selecting data from rows, columns
or cells in the application being scraped. Refer to 6 Grid/Cells Screen Scrape Example on
page 25 for more on configuring profiles for Grids/Cells.

OCR - This is usually used for any application that presents its data in a consistent layout
and where the information being scraped is in a consistent position relative to the top left
of the application window. It will not work well where screen layouts vary as the window is
resized. Use this option for Web applications, Java applications or applications running in
remote sessions like Citrix. See 7 OCR Screen Scrape Example on page 32 for how to create
an example OCR profile using the Sample Personnel Program.

O NOTE: While this option will work for most applications, it does use OCR to read the

screen contents, and so can be prone to occasional OCR errors. It is recommended
that you test the Screen Scrape Profile with a selection of different screen data
before deploying to users in a live environment.

The following sections 4 to 7 describe the steps to take in the Screen Scrape Setup wizard to
configure a profile for your chosen data capture method (selected in step 3 in the wizard).
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This example profile is for the Windows Objects data capture method using the Sample Personnel

Program. Follow the steps below to create the example profile.

To create a Windows Objects profile:

Navigate to the Document Manager program directory and double-click Employee.exe to

launch the Sample Personnel Program.

Ensure the Sample Personnel Program is the active window and press your defined hotkey.
Click Yes in the message prompt displayed to create a new profile. The Hotkey/Screen

Scrape Setup wizard displays:

Hotkey [ Screen Scrape Setup.

Step 1 - Select a drawer to search
Step 2 - Select whether the search is for & folder or document

Step 3 - Select the methed for capturing data from the applications window

Drawer Any

~ Search Type
(8 Folder Search/Create (Z) Document Search

[] Automatically open folder jdocument if only 1 match is found

~ Window Data Capture Method

(® Windows Objects - Use this for standard Windows applications

| Dos/Text - Use this for DOS applications, Terminal Emulation, Clipboard contents etc

() Grid/Cells - Use this for spreadsheets, applications that display data in a arid etc

I_1OCR - Use this for web pages, java apps, citrix sessions, other application types

| aCanceI |

| "'? MNext |

Select the '"Human Resources’ Drawer and ensure the Folder Search/Create option is

selected.
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Ensure the Windows Objects option is selected and click Next. Step 4 displays:

Hotkey / Screen Scrape Setup.

Step 4 - Select the features that uniquely identify the application window. E.g button mames, window
captions etc

Window Title |Sample Personnel Program

ClassMame [ 1hunderRTEFormOC | [C] 1gnore Class Name

Use Machine Name

0Object Ref Matches

Add = Remove

Window Objects

Use NonObjectd field identification
[#]-[*L Employee Details || ThunderRT&Frame || 1 ] 041

| Hcancel || & previous |17

Step 4 is to tell Document Manager how to identify this window from any other that may be active
when the hotkey is pressed. By default, this is done using the window title; however, frequently this
may not be enough. If there is only one screen layout for the program (as in the Sample Personnel
Program), the window title may suffice on its own.

If there are multiple screen layouts for the program (for example, a Finance program may have a
'list of suppliers’ window, or a 'list of transactions’ window etc.), you need to identify which window
the program is displaying.

It is possible to define multiple Screen Scrape profiles for an application (like a Finance application)
but only one Screen Scrape profile per window (such as a supplier details form).

If only the window title is needed to identify the window, you can simply click Next. For more
complex programs, you need to add some information about what the window is showing.

On the bottom half of the screen for step 4, expand the top-level object to display a list of
Windows Objects. This is a list of all objects read from the target application and consists of text
boxes, combo boxes, lists etc. For the Sample Personnel Program, it is a small list but in more
complex applications this list will be many levels deep.

N [DOCUMENT
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The format of the list is the actual data contained within the control separated by ‘||, then the
name of the control followed by ‘|| and the object ID of the control. Sometimes the object ID of the
control on the form changes and this makes it unreliable to use.

If this is the case, tick the box Use NonObjectld field identification and this will cause the
process to ignore the IDs when performing a match.

You need to identify items that differentiate the window from others that the program may display.
These items include the captions on the form, titles of fields etc. In the Sample Personnel Program
example, you could use the panel title ‘Employee Details’ or the field names, such as ‘Department’.

You would not use field values to identify the window, such as ‘Mr’ or ‘Cowell’, because these will
change depending on the window displayed (for example, an employee record). Field values are
used to provide the data to be searched and are defined in the next step, but now you need to
identify the correct window.

To identify the Sample Personnel Program window:

Highlight the first field 'Employee Details’ and click the Add button to add it to the list of
features used to identify the window. The result should look something like this:

Hotkey / Screen Scrape Setup.

Step 4 - Select the features that uniguely identify the application window. E.g button names, window
captions etc

Windaw Title |Sample Personnel Program

ClassName |'-'_-':5-'?"=_=:-' mOC | ["] 1gnore Class Hame

Use Machine Name

Object Ref Matches
Id1 ThunderRT6Frame Employee Details

. Use NonObjectid field identification
[__L Emplovee Details || ThunderRTeFrame || 1 ] 041
- [74, HR || ThunderRTE6ComboBox || 2 |] 04112
7L || ThunderRTaTextBaox || 3 || 04143
-[7L AB123456C || ThunderRTaTextBox || 4 || 0\1'4
[, Male || ThunderRTeComboBax || 5[] 04145
e[ M || ThunderRTaTextBox || 6 || 0416

- [, Gizma || ThunderRTeTextBox || 7 || 0V\F
-7 Cowell || ThunderRTeTextBox || & || 0\1\8
™1 12345 || ThunderRTETextRox 119 1104149

| ¥

| Rcancd || Eprevous || Hrext |
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It is possible to define multiple identification features but usually just one will suffice, as
long as it is unique to that window.

A ClassName is part of the way Windows identifies the window, for example, as an
application window as opposed to a Windows Explorer window. By default, this is also used
to identify the window to prevent mistaking a Windows Explorer window of the same name
in the Screen Scrape process. Sometimes, however, applications change their ClassName, so
if your Screen Scrape does not reliably work, check to see if the ClassName changes. If it
does, tick the Ignore Class Name option. However, this situation is quite unusual.

When the Window identification features have been defined, click Next to continue to steps

5, 6 and

7:

ey / Screen Scrape Setup.

Step 5 -
Step b -
Step 7 -

Select the window data to be used in the mapping
Map the window data to a field in Document Manager

Repeat for each field that is to be used for the search

<k Add ‘ | = Remove | | ™ Add Window Title

Window

Ohbjects

Use NonObjectTd field identification

[*L Employee Details || ThunderRT&Frame || 1 |] 041

-------------- [*L HR || ThunderRTeComboBox || 2 || 04142
-------------- [ || ThunderRTETextBox || 3 1] 04113

-[*L AB123456C || ThunderRTaTextBox || 4 |] 0V144
-------------- "L Male || ThunderRTeComboBox || 5 || 01145
-------------- [*L Mr || ThunderRTaTextBox || & || 0416

.............. [*L Gizmo || ThunderRTeTextBox || 7 || 0\1\7
-------------- 5 Cowell || ThunderRTaTextBox || & || 0418
-------------- [ 12345 |l ThunderB TETewtBow 109 1104149

| »

| 3 cancel H@Previous||§
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Now you need to define the fields in the application that you want to use to locate the documents
in Document Manager.

To select the data to be scraped:

Using the list of Windows Objects at the bottom of the screen, choose an object that
contains the data you want to search on. In an HR application, this would be something like
employee number, or in an Accounts Payable application, it could be invoice number. In this
example, choose the object that contains the data ‘Cowell".

Click Add to add the object data to the list in the top half of the screen:

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager

Step 7 - Repeat for each field that is to be used for the search

Object Ref Example Lookup Criteria
ThunderRT6Te Cowell

= Remove | | jAdd Window Title

Window Objects

Use NonObjectId field identification
S ["1 Employee Details || ThunderRTaFrame || 1 ] 041

- ["L HR || ThunderRT&ComboBox || 2 || 04142
[y || ThunderRTaTextBox || 3 1] 04143
- ["L AB123456C || ThunderRTETextBox || 4 || 04113
-------------- "L Male || ThunderRT&ComboBaox || 5 || 01145
-------------- "L Mr || ThunderRT&TextBox || &6 || 0Y16
[*L Gizmo || ThunderRT&TextBox || 7 || 04147
- "L Cowell || ThunderRT&TextBox || & || 018
-------------- [ 12345 |l ThunderBTaTewtBow 119 1101149

| ¥

| 3 cancel |[ Erevious || ehvext |

The object data will be added to the list in the top half of the screen.

You need to map the field just read from the application window to a field in Document Manager.
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To map the application data to a Document Manager field:

Lookup Click in the Lookup column to display a drop-down list of the available
|v fields in the ‘Human Resources’ drawer. Select the field that relates to our

Surname " . . ' '

First Name search data: in this case, ‘Surname’.

Click in the Criteria column to display a drop-down list of filter criteria. Criteria

Select ‘Equal To' from the list: this will tell Document Manager to locate EqualTo M
a folder with the Surname field ‘Equal To' the value read from the H{',t Equal To ﬁ
selected field in the application. Contains |

Other filter criteria may be selected, for example, ‘Contains’ or ‘Starts With'. See the Document
Manager User Guide for more information on searching for folders and using these filters.

Additional fields can be defined in the Screen Scrape profile by repeating the above process from
Step 5. For the Sample Personnel Program example, this is not necessary. In the Windows Objects
profile, the Screen Scrape Setup should look like the one below:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager

Step 7 - Repeat for each field that is to be used for the search

0Object Ref Example Lookup Criteria
Ids ThunderRT6Te Cowell Surname Equal To -

<F Add REmove ‘ ™ add window Title

Window Objects
Use NonObjectId field identification
L_L, Employee Details || ThunderRTaFrame || 1 ]] 041
- [*1. HR || ThunderRTaComboBox || 2 || 01142
=% || ThunderRT6TextBox || 3 || 04143
- [CL AB123456C || ThunderRTeTextBox || 4 || 04144
[ Male || ThunderRTeComboBox || 5 || 04145
-1 Mr || ThunderRTeTextBox || & || 04116
-2 Gizmo || ThunderRTeTextBox || 7 || 0VVF

- [, Cowell || ThunderRTeTextBox || 8 || 0V1\5
~ ™1 12345 || ThunderBTaTextBox 119 1101119

[ »

| 3 cancel || rrevous || Biext |
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Click Next to display step 8:

Hotkey /

Screen Scrape Setup.

Step 8 - Some applications require spedial commands to make the data available, these are typically only
used when needing to copy data to the dipboard, usually for Terminal Emulators or Spreadsheets, If this is
the case define any keystrokes necessary to copy the data to the Clipboard, This is typically Cirl C or
sometimes Alt E to select the Edit Menu, followed by C to copy (Optional Step)

Select box and press the reguired key sequence

| < Add | | § Move Up |

| = Remaove | | f Mawe Down|

This step is usually only for Terminal Emulation sessions and Spreadsheets, and is used to define
any key presses the application needs in order to paste data to the Windows Clipboard.

For this example, Step 8 is not required, so click Next:

| xCan::el || i—JPreuiuus |

Step 9 in the wizard displays:

Hotkey / Screen Scrape Setup.

Step 9 - Give the profile a meaningful name, typically describing the application name, window function and
possibly screen resolution

Profile Mame Sample Personnel Program

Finally, you need to give the Screen Scrape profile a name so it can be identified later. This is
usually the same as the window title, but sometimes you need to add some more information,
typically to identify with which form in the application the profile works.

Enter a unique and recognisable Profile Name, and then click Save to save the Screen
Scrape profile:

| Rl | [Ews)[ o |

It is now ready to be tested and used.

Congratulations; you have just defined your first Screen Scrape profile. With practice the whole
process will take just a few minutes.
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Performing a Screen Scrape from a DOS Window is similar to Screen Scraping from a spreadsheet

(as shown in the 6 Grid/Cells Screen Scrape Example on page 25). The displayed window's contents
are copied to the clipboard during both scrape processes; however, for a DOS/Text scrape, it is not
necessary to force the copy using a sequence of key presses.

O NOTE: DOS applications can only be Screen Scraped when running in a reduced window.
The scrape cannot be performed when running full screen.

The example used in this section will be with a legacy database written for MS-DOS using Clipper.

Figure 3 below represents a product specification sheet. From this specification sheet, a user may
access related documents, such as service manuals, user guides, and so on.

S:AAPPS\EPSIS\EPSIS2.EXE

Printer Specification

DFi-80804

Type ? Pin Dot Matrix

Quality Mear Letter Quality

Price 2999 .80 Order Ho.: CB3IBAZ1
Replaces MOTHING Rplcd By = WOME

: 136

: 216 ~ 188

Carriage Wide CPL 18cpi
Sdize{HUD>: 367 ~ 788 .~ 382 Grf Res

Availahle: A Launch : A1/85-98 Uithdrawn: P
Decibels = 55 Weight kg: 27.808 Copies b
Buffer{K>: 3 Switches : 3 Emulation:= IBHM ESC-P
Jumpers = 7 Selectype: ¥ Colour NO

Speed in Characters per Second

Figure 3: Example DOS Window

The steps below describe how to set up a Screen Scrape profile for the example DOS window in
Figure 3 above.
To create a DOS Screen Scrape profile:

Open the DOS Window and run the required command.

Ensure the DOS Window is the active window and press your defined hotkey. Click Yes in
the message prompt displayed to create a new profile. The Hotkey/Screen Scrape Setup
wizard displays.
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Select your required Drawer, for example ‘"Human Resources’ and choose the Dos/Text
option under Window Data Capture Method:

~Window Data Capture Method

(2 windows Objects - Use this for standard Windows applications

(%) Dos/Text - Use this for DOS applications, Terminal Emulation, Clipboard contents et

() Grid/Cells - Use this for spreadsheets, applications that display data in a grid etc

(Z) OCR. - Use this for web pages, java apps, dirix sessions, other application types

Click Next to display step 4:

Step 4 - Select the features that uniguely identify the application window. E.g button names, window
captions etc

Window Title  |C:\Jsers\STEVE~1.ADA \Desktop\EPSIS\EPSIS2.EXE

ClassName |I:'::f ndowClass ||:|1gnnr\eclassllame

Object Ref Matches

[ <+ Add H = Remove

oo ! EFSON (UK} LTD. — TECHNICAL SEEVICES I .
10 Sep 2009 | FRODUCT INFOEMATION w 2. 50|

EPSOH ! Printer Specification H
} + 1 DF¥-8000 —————

| Speeds ! !

|Font= ! | Type : 9 Pin Dot Matrix

|Pitches ! IQuality : HNear Letter Quality

1Stvles ! |Price 299900 QOrder Ho -
‘| T | .

[ xCam:el ][@Preuiws” EkNext ]

Step 4 is to tell Document Manager how to identify this window from any other that may be active
when the hotkey is pressed. By default, this is done using the window title; however, frequently this
may not be enough. If there is only one screen layout for the program (as in the Database Program
example), the window title may suffice on its own.
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If there are multiple screen layouts for the program (for example, a Finance program may have a
'list of suppliers’ window, or a ‘list of transactions’ window etc.), you need to identify which window
the program is displaying.

It is possible to define multiple Screen Scrape profiles for an application (like a Finance application)

but only one Screen Scrape profile per window (such as a supplier details form).

If only the window title is needed to identify the window, you can simply click Next. For more
complex programs, you need to add some information about what the window is showing.

To identify the DOS screen:

Select some text that is always present on the screen. To do this, position the mouse cursor
immediately before the required text in the Dos/Text tab at the bottom of the window.
Holding the <SHIFT> key down, move the cursor to the right to highlight the desired
word(s). In the above example, 'PRODUCT INFORMATION v 2.50" is highlighted.

Once you have highlighted the required area, click the Add button to add this to the list of
features used to identify the window. The result should look something like this:

Hotkey / Screen Scrape Setup.

Step 4 - Select the features that uniguely identify the application window. E.g button names, window
caplions etc

Window Title  |C:\Users\STEVE~1,ADA\Desktop\EPSIS \EPSIS 2. EXE
ClassMame |::-:;;_ "dowClass | [ 1gnore Class Name

Object Ref Matches
Text Line 2 Col 29 PRODUCT INFORMATION v 2.50

[ < Add §|[-R.emcue

Dos [ Text

oo ! EFSON (UK) LTD. — TECHNICAL SEREVICES DN .
10 Sep 2009 | PRODICT IHNFORMATION + 2.G50

EFSOH ! Printer Specification H
} +o1 DFE-8000  —————

| Speeds ! !

|Font= ! | Type 9 Pin Dot Matriz

IPitches I ltmality :  Hear Letter Quality

1Styles ! |Price © 2999 .00 DOrder Ho -
4| 1 | r

[ xCanceI ”threvious.” Ekhlext ]
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3. When the identification features have been defined, click Next to go to steps 5, 6 and 7:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager
Step 7 - Repeat for each field that is to be used for the search

[ <k Add ] [-Rﬂnutre] [jhddwmduw'l_'lﬁe

Dos [ Text

on ! EPSOH (UK) LTD. — TECHHNICAL SEEVICES Il .
10 Sep 2009 | FRODUCT IHNFCRMATION + 2.50

EFSOH | Frinter Specification H
t i DF¥-g00o0 —————

| Speeds= | |

|Font= | | Type 9 Pin Dot Matrix

|Pitches= | uality  Hear Letter Quality

|Styles=s | |Price © 2999 .00 Order Ho -
< | 1 | 3

[ xcancel H@P‘reviws][ @Next ]

5.2  Step 5: Selecting the Application Data to be Scraped

Now you need to define the fields in the application that you want to use to locate the documents
in Document Manager.

To select the data to be scraped:

1. In the same way as in step 4, select some text that is always present on the screen. To do
this, position the mouse cursor immediately before the required text in the Dos/Text tab.
Holding the <SHIFT> key down, move the cursor to the right to highlight the desired
word(s). In the above example, 'DFX-8000" is highlighted.

'IDOCUMENT
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Click Add to add the object data to the list in the top half of the screen:

Step 5 - Select the window data to be used in the mapping

Step 6 - Map the window data to a field in Document Manager

Step 7 - Repeat for each field thatis to be used for the search

Object Ref Example Criteria

Text Line 6 Col 44 L DFX-8000

Annotation Text
Sub Folder Name
Document Id

- Checked Qut To
4 Add = ™ Add Window Propertics

Access From
Storage Media

Screen Scrape Guide

oo ! EFSON (UK) LTD. — TECHNICAL SEEVICES I .
10 Sep 2009 | FPRODUOCT INFORMATION « 2 .50 T
EFS0OH ! Printer Specification =
} + 1 DFE-go00  —————
|Speads ! !

|Font= ! | Type 9 Pin Dot Matrixz

|Pitches= ! IQuality : HNear Letter Quality

1Styles ! |Price © 2999 .00 Qrder Ho -
4| i | b

[ xCancel ][@Preuiws][ l".'kNext ]

The DOS data will be added to the list in the top half of the screen.

You need to map the field just read from the application window to a field in Document Manager.

To map the application data to a Document Manager field:

Lookup | Click in the Lookup column to display a drop-down list of available fields
— _ in the selected drawer. Select the field that relates to our search data: in
Doc Description this example above, this is ‘Name'.

Date Created
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Click in the Criteria column to display a drop-down list of filter
criteria. Select ‘Equal To' from the list: this will tell Document
Manager to locate a folder with the Name field ‘Equal To’ the
value read from the selected field in the application.

Other filter criteria may be selected, for example, ‘Contains’ or ‘Starts
With'. See the Document Manager User Guide for more information on
searching for folders and using these filters.

Screen Scrape Guide

Criteria
Equal To -

1] -~
Mot Equal To
Contains

Does Not Contain
Less Than

Less Or Equal To
Greater Than
Greater Or Equal T —

m

Additional fields can be defined in the Screen Scrape profile by repeating the above process from

Step 5. For the DOS Window example, this is not necessary.

The Screen Scrape profile for a DOS Window should look like the example below:

Hotkey / Screen Scrape

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager

Step 7 - Repeat for each field that is to be used for the search

Object Ref Example Lookup Criteria

Text Line & Col 44 L DFX-8000 Name Equal To

<k Add = Remoyve [j.ﬁdd Window Title

Dos [ Text
oo ! EPSON (UK) LTD. — TECHNICAL SEREVICES Iv .
10 Sep 2009 | PRODUCT INFORMATION + 2.50
EPSON | Printer Specification H
t S § DF¥-a000 ————
| Speed= | |
|Font= | | Type 9 Pin Dot Matrix
|Pitches | juality : Hear Letter Quality
|Style= | |Price © 2999 .00 Order Ho -
4 | Tl | b

[ xCancel ][@Preuious][ Ebhlext ]
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Click Next to display step 8:

Hotkey / Screen Scrape Setup.

Step & - Some applications require special commands to make the data available, these are typically only
used when needing to copy data to the dipboard, usually for Terminal Emulators or Spreadsheets. If this is
the case define any keystrokes necessary to copy the data to the Clipboard. This is typically Ctrl C or
sometimes Alt E to select the Edit Menu, followed by C to copy {Optional Step)

Select box and press the required key sequence

| < add | | -'il"-"ln'u'eUp|

| = Remove | | t‘ Mawve Duwn|

This step is usually only for Terminal Emulation sessions and Spreadsheets, and is used to define
any key presses the application needs in order to paste data to the Windows Clipboard.

For the DOS Window example, Step 8 is not required, so click Next:

Hotkey / Screen Scrape Setup.

Step 9 - Give the profile a meaningful name, typically describing the application name, window function and
possibly screen resolution

Profile Name  |bos window: Printer Spedfication|

Finally, you need to give the Screen Scrape profile a name so it can be identified later. This is
usually the same as the window title, but sometimes you need to add some more information,
typically to identify with which form within the application the profile works.
Enter a unique and recognisable Profile Name, and then click Save to save the Screen
Scrape profile. It is now ready to be tested and used.
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Running a Screen Scrape from a grid or cells is similar to scraping from a DOS Window, as
described in 5 DOS/Text Screen Scrape Example on page 18. In the example shown in this section, a
spreadsheet of ‘Personnel Records’ in Microsoft Excel is used (see Figure 4 below). The steps below
describe how to set up a Screen Scrape profile for the example ‘Personnel Records’ spreadsheet.
To create a Grid/Cells Screen Scrape profile:

Open the required application, for example, a spreadsheet (as shown in Figure 4).

Select the cells containing the relevant fields. In the example below, the entire row has been

selected:
L EI Ty
0a)) g0~ Personnel Records.xlsx - Microsoft Excel El_lg
.. l_*;d- L ~
“-—-/ Home Insert Fage Layout Formulas Data Review View Add-Ins @ - g X
““3 % calibri -1 - |= ==|5 | Genera - Al el E- &7 -
FTaste = |B £ g Y”A‘ Avl |§ = E|@v |%Y l | Styles || Cells EY %Y
- I [Ee-A ([EEH] (WS O (e
Clipboard ™ Faont IF] Alignment P Mumber = Editing |
Al - 'i‘ y 2 | Cowell ¥
A B ¢ [ b | E F | 6 |p
1 h:owell Timothy Mark X¥443322117 =
2 |Smith Hannah AHBTE52G
3 Booker Paul CD12345Y
4 |Myers Leo YH5343456E
4 4 + M| Sheetl ~Sheet? . Sheet3 . ¥1 L I |
Ready | Count: 3 ()R O ] B +
L A

Figure 4: Example Personnel Records Spreadsheet

When defining the Screen Scrape profile, the row of data must be copied to the clipboard
(this will not be necessary once the template has been defined). To do this in Excel,
depending on your version, select Edit and then Copy or click the copy button 53 on the
Home tab.

O NOTE: <CTRL> + <C> is common to most Windows applications for copying

selected data to the Clipboard and is always a good starting point if unsure what keys
to use. <CTRL> + <A> is common to many Windows applications for selecting all
items in a Window prior to the ‘Copy to Clipboard’ action. Make a note of the keys
used (these will be needed later when defining the screen scrape template).

Ensure the spreadsheet is the active window and press your defined hotkey. Click Yes in the
message prompt displayed to create a new profile. The Hotkey/Screen Scrape Setup
wizard displays.
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Select your required Drawer for example, ‘Human Resources’, and choose the Grid/Cells
option under Window Data Capture Method:

~Window Data Capture Method

(2 windows Objects - Use this for standard Windows applications

(") Dos/Text - Use this for DOS applications, Terminal Emulation, Clipboard contents etc

(®)i5rid/Cells - Use this for spreadsheets, applications that display data in a arid etc

(Z) OCR. - Use this for web pages, java apps, dirix sessions, other application types

Click Next to display step 4:

Step 4 - Select the features that uniguely identify the application window. E.g button names, window
captions etc

Window Title |I'~"Iicrosoﬁ Excel - Personnel Records. xlsx

ClassMame |>{LI‘~'1.-5.IN | [| 1gnore Class Name

0Object Ref Matches

e Add = Remove

Grid / Cells

Cowell
Timothy Mark
¥Y443322117

[ xCan-:eI Hthreuious]E th.lext 1

Step 4 is to tell Document Manager how to identify this window from any other that may be active
when the hotkey is pressed. By default, this is done using the window title; however, frequently this
may not be enough. If there is only one screen layout for the program (as in the Personnel Records
spreadsheet example), the window title may suffice on its own.

RN [ DOCUMENT
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If there are multiple screen layouts for the program (for example, a Finance program may have a
"list of suppliers’ window, or a ‘list of transactions’ window etc.), you need to identify which window
the program is displaying.

It is possible to define multiple Screen Scrape profiles for an application (like a Finance application)
but only one Screen Scrape profile per window (such as a supplier details form).

If only the window title is needed to identify the window, you can simply click Next. For more
complex programs, you need to add some information about what the window is showing.
To identify the Spreadsheet Cells:

1. To reference the spreadsheet cell fields, click the Grid/Cells tab in the lower half of the
window in Step 4. This lists each of the selected cells on a different line. In the case of the
Personnel Records spreadsheet, the window title is sufficient to identify the application so
no additional identity fields are required.

2. When identification features have been defined, click Next to go to steps 5, 6 and 7:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager
Step 7 - Repeat for each field that is to be used for the search

| 4add | [ =Remove | | = add window Titl

Grid f Cells
cowe!l ]

Timathy Mark
X¥443322112

| ¥ cancel | | € previous | | P Next |

DOCUMENT
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6.2 Step 5: Selecting the Application Data to be Scraped

Now you need to define the fields in the application that you want to use to locate the documents
in Document Manager.

To select the data to be scraped:

1. Select the cell you want to add as a lookup. In this example, select the cell ‘Cowell".

2. Click Add to add the object data to the list in the top half of the screen:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager
Step 7 - Repeat for each field thatis to be used for the search

[ <S¢ Add ] [-R.emove] [3hddWindow

Grid [ Cells

=
Timothy Mark
XYa43322112

| Hcancel | | &iprevious || D next |

The cell data will be added to the list in the top half of the screen.

6.3 Step 6: Mapping the Application Data to Document
Manager Index Fields

You need to map the field that has just been read from the application window to a field in
Document Manager.

L
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To map the application data to a Document Manager field:

Lookup 1. Click in the Lookup column to display a drop-down list of the available
|v fields in the selected drawer. Select the field that relates to our search data:
Surname s B h 1 1]
First Name [ in this case ‘Surname’.
2. Click in the Criteria column to display a drop-down list of filter criteria. Criteria
Select ‘Equal To’ from the list: this will tell Document Manager to locate ght
a folder with the Surname field ‘Equal To’ the value read from the Not Equal To ﬁ
selected field in the application. Contains

Other filter criteria may be selected, for example, ‘Contains’ or ‘Starts With'. See the Document
Manager User Guide for more information on searching for folders and using these filters.

6.4 Step 7: Map Additional Fields

Additional fields can be defined in the Screen Scrape profile by repeating the above process from
Step 5. For the Grid/Cells example, this is not necessary.

The Screen Scrape profile for Grid/Cells should look like the example below:

Hotkey [/ Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager
Step 7 - Repeat for each field that is to be used for the search

0Object Ref Example Lookup Criteria
Cell 1 Cowell Surname Equal To -

[ <r Add ] | = Remove | [jhdd Window Title

Grid / Cells
=

Timothy Mark
XY443322112

l xCancel H@Previous” E&Next ]

DOCUMENT
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Click Next to display step 8:

Hotkey / Screen Scrape Setup.

Step & - Some applications require special commands to make the data available, these are typically only
used when needing to copy data to the dipboard, usually for Terminal Emulators or Spreadsheets. If this is
the case define any keystrokes necessary to copy the data to the Clipboard. This is typically Ctrl C or
sometimes Alt E to select the Edit Menu, followed by C to copy (Optional Step)

Select box and press the required key sequence

| <k Add | | -'iMuveUp|

| = Remove | | t Move Duwn|

The final step in defining the profile is to automate the copying of data to the clipboard. This is
performed by defining the key presses Document Manager will perform automatically.
To define an automatic action to copy to the clipboard:

Position the cursor in the text box at the top left of the screen, and then press <CTRL>
followed by <C>. The text window will display a ‘Ctrl" with a small ‘c":

Hotkey / Screen Scrape Setup.

Step & - Some applications require special commands to make the data available, these are typically only
used when needing to copy data to the dipboard, usually for Terminal Emulators or Spreadsheets. If this is
the case define any keystrokes necessary to copy the data to the Clipboard. This is typically Ctrl C or
sometimes Alt E to select the Edit Menu, followed by C to copy (Optional Step)

Select box and press the required key sequence

<F Cirlc § Move Up

TIP: Sometimes an application appears not to respond to the key presses (e.g.

® <CTRL> + <C>). If this is the case, try defining the key presses twice; sometimes the
application detects the second one. This varies from application to application, but
frequently resolves the problem where the key presses initially appear not to work.
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Click Add and the key sequence will be added to the list. Repeat this for each key sequence
required to gather the data. The key sequences can be moved up and down the order using
the Move Up and Move Down buttons on the right. Use the Remove button to remove
any sequences from the list.

When finished, click Next to display step 9:

Hotkey / Screen Scrape Setup.

Step 9 - Give the profile a meaninaful name, typically describing the application name, window function and
possibly screen resolution

Profile Name | Microsoft Excel - Personnel Records. xlsx

Finally, you need to give the Screen Scrape profile a name so it can be identified later. This is
usually the same as the window title, but sometimes you need to add some more information,
typically to identify with which form within the application the profile works.
Enter a unique and recognisable Profile Name, and then click Save to save the Screen
Scrape profile. It is now ready to be tested and used.
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This example uses the Sample Personnel program to demonstrate setting up an example OCR
Screen Scrape profile. Follow the steps below to create the example profile.

To create an example OCR profile:

Navigate to the Document Manager program directory and double-click Employee.exe to
launch the Sample Personnel Program.

Ensure the program is the active window and press your hotkey. Click Yes in the message
displayed to create a new profile. The Hotkey/Screen Scrape Setup wizard displays.

Select a Drawer (for example, '"Human Resources’) and choose the OCR option under
Window Data Capture Method:

Window Data Capture Method
() Windows Objects - Use this for standard Windows applications
| DosfText - Use this for DOS applications, Terminal Emulation, Clipboard contents etc

(1 Grid/Cells - Use this for spreadsheets, applications that display data in a grid etc

(#)0CR. - Use this for web pages, java apps, citrix sessions, other application types:

Click Next to display step 4:

Hotkey / Screen Scrape Setup.

Step 4 - Select the features that uniguely identify the application window. E.q button names, window
captions etc

Window Title |Sample Personnel Program

ClassMame |—-_ nderRTEFarmoC | [ 1gnore Class Name

Object Ref Matches

% add = Remove
OCR
Value Read
OCR Zone Left Top Height Width
I I [ Select Feature

[x Cancel l H:l Preuious] kl!b MNext i
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7.1  Step 4: Identify the Window

Step 4 is to tell Document Manager how to identify this window from any other that may be active
when the hotkey is pressed. By default, this is done using the window title; however, frequently this
may not be enough.

If there is only one screen layout for the program (as in the Sample Personnel Program), the
window title may suffice on its own.

If there are multiple screen layouts for the program (for example, a Finance program may have a
'list of suppliers” window, or a ‘list of transactions’ window etc.), you need to identify which window
the program is displaying.

It is possible to define multiple Screen Scrape profiles for an application (like a Finance application)
but only one Screen Scrape profile per window (such as a supplier details form).

If only the window title is needed to identify the window, you can simply click Next. For more
complex programs, you need to add some information about what the window is showing.
To identify the Sample Personnel Program window for an OCR profile:

1. On the OCR tab in the bottom half of the screen, click the Select Feature button to open
the OCR Image View window, as shown below:

l E OCRImage View

Yalue Read | | Zohe | | 2 Add

Drrag the mouse aver the required area on the image and check the value read is carect

G0O0IEG )2

r
[3 Sample Personnel Program ==

—Emplopee Details

Staff Number [12345

Lastname ICoweII

First Name(s) |Gizmo

Title ||l..-1r Sex IMaIe -I

Mational Ins No [AB123456C

Home Phone ||
Department IHFi j
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This shows a screenshot of the application window at the time you pressed the hotkey.

You need to identify items that differentiate the window from others that the program may
display. These items include the captions on the form, titles of fields etc. In the Sample
Personnel Program example, you could use the panel title ‘Employee Details’ or the field
names, such as ‘Department’.

You would not use field values to identify the window, such as ‘Mr" or ‘Cowell’, because
these will change depending on the window displayed (for example, an employee record).
Field values are used to provide data to be searched and are defined in the next step, but
now you need to identify the correct window.

Using the mouse, drag a rectangle around the Employee Details caption (you can click the
magnifying glass icon (‘&) on the toolbar to zoom into the image and more easily select
the required area):

Ermployes Detailz|H

When you release the mouse button, the inside of the rectangle area will be read by OCR
and the resulting data displayed in the Value Read field at the top of the form.

Yalue Read £one

Check that the value read was correct. If it is not, try selecting a slightly different area
around the title. It is possible that other text or graphics interfere with the OCR. Aim to
encompass all the text that you are trying to capture without actually touching it.

O NOTE: If after repeated attempts, you cannot reliably OCR the field, it is likely the

OCR engine is not capable of reading the font or the text, possibly due to layout of
the form or colours and shading used. In this case, you can use settings on the
Integration tab in User Settings to generate a black and white (mono) OCR image.
This may improve the accuracy of the OCR process. See 2.2 Producing Black and
White OCR Images on page 6 for how to do this.

You could also try one of the alternative Screen Scrape methods. If these do not
work, the application may be one of the few that cannot be successfully screen
scraped.
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When you have successfully defined the area and it is read by OCR correctly, click Add to
close the OCR Image View and return to the Screen Scrape configuration. The details read
will be summarised:

QCR

Value Read

Employee Details

OCR Zone Left Top Height Width

[ 14 29 13 89| [ select Feature

]

This indicates what was read and where on the screen it was located.

Click Add in Hotkey / Screen Scrape Setup to add the Employee Details caption to the
list of features used to identify the window. The result should look similar to this:

Step 4 - Select the features that uniquely identify the application window. E.g button names, window
captions etc

Window Title |Sam|:b|e Personnel Program

ClassMame |_--_--_-§.-:\—:_::_..\.—~ — | Ignnr\e Class Name

Use Machine Name

0Object Ref Matches

| = Remove
OCR
Value Read (P, b loyee Details
OCR Zone Left Top Height Width

| 16 30 14 84| | Select Feature

| xcancel ||thrE'u'iw5|| Ekl'\lext |

It is possible to define multiple identification features but usually just one will suffice, as
long as it is unique to that window.

)
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Ignore Class Name: A ClassName is part of the way Windows identifies a window, for
example, an application window as opposed to a Windows Explorer window. By default, this
is also used to identify the window to prevent mistaking a Windows Explorer window of the
same name in the Screen Scrape process. Sometimes, however, applications change their
ClassName, so if the Screen Scrape does not reliably work, check to see if the ClassName
changes. If it does, tick Ignore Class Name. However, this situation is quite unusual.

Use Machine Name: (This option only applies to Screen Scrape OCR profiles.) Typically, not
all users in your organisation have the same screen resolutions on their workstations. If
users with different resolutions run the same OCR Screen Scrape profile, they will have
different results and the correct data may not be read. To prevent this, select the Use
Machine Name checkbox. This links the profile to the current machine so that when the
OCR Screen Scrape is run on that machine, it will use the correct OCR profile. If you select
Use Machine Name, the profile must be set up on the machine that will run the Screen
Scrape. Make sure when you name your profile in step 9, you use a name that can easily
identify with which workstation/user the profile is linked.

When all the Window Identification features have been defined, click Next to continue to
steps 5, 6 and 7:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager
Step 7 - Repeat for each field that is to be used for the search

[;}. Add ] [- Fbemo-.re] [3 Add Window Title

QCR

ValueRead |Fyployee Details

OCR Zone Left Top Height Width
[ 14 29 13 89| [ Select Data

[x Cancel ] [t‘ Previous ] E@ Mext i

'IDOCUMENT
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7.2

Step 5: Selecting the Application Data to be Scraped

Now you need to define the fields in the application that you want to use to locate the documents
in Document Manager.

To select the data to be scraped:

1. You need to select the field data from the application window, so click the Select Data

2.

button on the OCR tab. The OCR Image View window displays again, but this time you are
going to select the actual fields that you want to use in our search:

. B OCR Image View

Value Read |Frplyee Details | Zone [L14T:28H1389 | [+ add

Dirag the mousze owver the required area on the image and check the value read iz comect

GO0IRR 2

B3 Sample Personnel Program (|| (]

—Emplopee Details

Staff Number [12345

Lastname |Cowell

First Name(s) |Gizmo

Title ||l,.-1r 3ex IMaIe -.-I

MNational Ins No |AB123456C

Home Phone ||

Department I HR j

Identify the first field you want to perform your search on, which in this example is
Lastname, and drag a rectangle around the actual field area that contains the data:

Laztname ||I:|:|we||

Zoom into the image to more easily select the required area. Make sure the rectangle
includes the entire possible area where data can be displayed but does not touch the edges
or the actual text of the data. Ideally, there should be space between the rectangle and the
data being read.

L
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3. When you release the mouse, the area will be read by OCR and displayed in the Value Read

box at the top of the OCR Image View window:

Value Read | oyyg)| £ane || 195 T:95,H:13.4/163

If the value is incorrect, try selecting a slightly different area around the field.

When you have successfully read the field, click the Add button to return to the Hotkey /

Screen Scrape Setup screen.

Click Add in the Hotkey / Screen Scrape Setup screen to add the OCR zone to the list in
the top half of the screen:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager
Step 7 - Repeat for each field that is to be used for the search

Object Ref Example Lookup Criteria
195,96,14,163 Cowell

= Remove | | jhdd‘.ﬂmdow'l_'lﬂe

OCR
Value Read Cowell
OCR Zone Left Top Height Width
| 195 96 14 163) | Select Data

| # cancel ||¢lpremus|| = Next

The data read by OCR will be added to the list in the top half of the screen.

7.3

Step 6: Mapping the Application Data to Document

Manager Index Fields

You need to map the field just read from the application window to a field in Document Manager.

IDOCUMENT
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To map the application data to a Document Manager field:

Screen Scrape Guide

Lookup Click in the Lookup column to display a drop-down list of the available

|" fields in the selected drawer. Select the field that relates to our search data:
Surname - . . ' '
Farst Baame B in this case 'Surname’.

Click in the Criteria column to display a drop-down list of filter criteria.
Select 'Equal To' from the list: this will tell Document Manager to locate
a folder with the Surname field ‘Equal To’ the value read from the
selected field in the application.

Criteria

Equal To -

Mot Equal To n
Contains ﬂ

Other filter criteria may be selected, for example, ‘Contains’ or ‘Starts With'. See the Document
Manager User Guide for more information on searching for folders and using these filters.

Additional fields can be defined in the Screen Scrape profile by repeating the above process from
Step 5. Do this now for the First Name field by following the instructions in steps 5 and 6.

After completing the steps for the First Name field, the Screen Scrape Setup should look like this:

Hotkey / Screen Scrape Setup.

Step 5 - Select the window data to be used in the mapping
Step 6 - Map the window data to a field in Document Manager

Step 7 - Repeat for each field that is to be used for the search

Object Ref Example Lookup Criteria
OCR 195,95,13,161 Cowell Surname Equal To
oCR 195,127,13,16. Gizmo First Name Equal To -

o Add = Remaove [j Add Window Title

OCR

Value Read | A 1 193456C

OCR Zone Left Top Height Width
[ 195 191 13 107] | selectpata |

[x Cancel ] [&l Previous ] [Ek Mext ]
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Click Next to display step 8:

Hotkey / Screen Scrape Setup.

Step & - Some applications require special commands to make the data available, these are typically only
used when needing to copy data to the dipboard, usually for Terminal Emulators or Spreadsheets. If this is
the case define any keystrokes necessary to copy the data to the Clipboard. This is typically Ctrl C or
sometimes Alt E to select the Edit Menu, followed by C to copy {Optional Step)

Select box and press the required key sequence

| < add | | -'il"-"ln'u'eUp|

| = Remove | | t‘ Mawve Duwn|

This step is usually only for Terminal Emulation sessions and Spreadsheets, and is used to define
any key presses the application needs in order to paste data to the Windows Clipboard.

For this example, Step 8 is not required, so click Next to display step 9:

Hotkey / Screen Scrape Setup.

Step 9 - Give the profile @ meaningful name, typically describing the application name, window function and
possibly screen resolution

Profile Name |Sample Personnel Program (OCR) |

Finally, you need to give the Screen Scrape profile a name so it can be identified later. This is
usually the same as the window title, but sometimes you need to add some more information,
typically to identify with which form in the application the profile works.

O NOTE: If you selected the Use Machine Name option in step 4, ensure you use a name that
can easily identify which workstation/user the profile is linked with.

Enter a unique and recognisable Profile Name, and then click Save to save the Screen
Scrape profile. It is now ready to be tested and used.

LOGISTIX
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Once you have configured a Screen Scrape profile, it is suggested that you test it before making it
available to users. Try closing the application, restarting it and testing the Screen Scrape again.

Test the Screen Scrape with the application window at different positions on the screen, and if
relevant, at different screen sizes (full screen and normal). You may need to define separate Screen
Scrape profiles for each screen size.

To test the screen scrape, simply open the application window and press the hotkey. The
Hotkey Capture in Progress message should be displayed briefly:

HotKey Capture in Progress.

The folder relating to the employee should then be located and opened in Document Manager.

If the Screen Scrape is for a folder search and the required folder does not exist, you will be
prompted with a Create New Folder dialog box:

Create Mew Folder

Drawer | [2 [ef’ Ok Jla Cancel ]

[E Access Permissions ]

Field Mame Walue
Surname Cowell

Firgt M ame Boris
Employes Mo

Gender

Department

Drate of Birth

Mat Inz Mo

Access From

Figure 5: Create New Folder Dialog Box from Screen Scrape

The fields that were ‘scraped’ from the application window will be populated automatically and the
remaining required fields (those highlighted in yellow) will need to be completed manually.

It may be possible to 'scrape’ all the required fields from the host application so that no fields
require manual completion. If this is the case, Screen Scraping can be a useful way of creating
folders without having to re-key information from an external application.
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O NOTE: When using Optical Character Recognition (OCR) to screen scrape, the position of

the fields on the window is very precise. Some applications lay out their windows differently
depending on screen resolution, or whether the application is running full screen. Web
pages are typical examples of this.

The note above does not mean that OCR screen scraping cannot work; it just means more thought
needs to go into its definition.

You may need to define multiple Screen Scrape profiles, one for each window size (800 x 600,
1024 x 768 etc.).

Use Window Identifiers that are going to move when the Window is resized; that way you can
define a profile for each commonly-used window size.

If the field being ‘scraped’ is a data entry field that has a flashing text cursor (| ) when selected,
educate users to ensure that the field is not selected at the time the hotkey is pressed. This is
because the cursor (| ) could be picked up by OCR and therefore interfere with the required data.
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To modify a Screen Scrape profile:

Click the File tab and select Screen Scraping. The Hotkey / Screen Scrape Definitions
dialog box displays:

S HotKey / Screen Scrape Definitions.

Microzoft Excel - Personnel A ecordz. «lzx
Sample Perzonnel Program

[ £ wodty | [ #pekte |

Select the required profile and click Modify. The Hotkey Screen Scrape Setup dialog box
displays enabling you to modify an existing profile. However, you can only modify some
aspects of the profile; some of the options are not available to be changed.

Where the modifications required are extensive, it may be more appropriate to delete the existing
profile.

To delete an existing profile:

Select the profile and click the Delete button. The profile is then removed from the
Hotkey / Screen Scrape Definitions dialog box.

To define a replacement profile, refer to 3 Screen Scrape Profile on page 7.
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